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Introduction

Introduction
The Library Wizard is a complete Library Management System designed for
library personnel. It does everything a librarian does on a daily basis.
It's a Circulation, Card Catalog, and Inventory System for:
• Books
• Magazines
• Audio-Visual
• Cassettes
• and much more...
NETWORK READY
It comes Network ready, at no additional charge. That means one computer
can be used for a Card Catalog. Another computer can be used for
circulation. Still another computer can be used by the librarian to
print reports and enter information about books to purchased.
RELATED SUBJECTS BROWSE
Imagine being able to browse through your entire library by a specific
related subject. Now, you can! Simply enter the related subject and
press <Enter>. Simply press one key to browse through every book in the
library for the related subject you entered. Research was never easier.
Student librarians can check books in/out quickly and accurately. All
books fines are calculated and tracked for you.
You'll print a wide variety of reports to the screen or printer. You can
even print spine labels, card labels, and card catalog cards.
BAR CODES
The program already comes with the ability to print bar codes. All you
have to do is purchase a bar code wand. With a bar code wand,
circulation and inventory can be done fast and accurately.
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Chapter 1: Getting Started
Installation
Place the Library Wizard Program Diskette # 1 in
your Floppy Drive A (or B).
Windows 3.X
From the 'File' Menu of the Windows Program Manager, select Run.
Windows 9x
From the 'Start' button of the Windows 95 task bar, select Run.
Enter the following:
A:install [Enter]
B:install [Enter].

or

Press [Enter] for each option that appears on the screen. When the
program has been successfully installed, the final message you'll see
will be "Installation is complete". Put the original program
diskette(s) in a safe storage place.
Installing Bar Code Font
In order to print bar codes, you must install the bar code font. To do
this:
Windows 3.X
1) From the Control Panel, select Fonts
2) Put the last Master Diskette in Drive A. Select Add.
3) Select drive A (to look for the font).
4) In the 'List of Fonts' box, select BC CBar 2 to 1 Narrow (True Type).
5) Select OK.
Windows 9x
1) From Start, select Settings.
2) Select Control Panel.
3) Select Fonts.
4) Under the File Menu, select "Install New Font"
5) Put the last Master Diskette in Drive A. Select Add.
6) Select drive A (to look for the font).
7) In the 'List of Fonts' box, select BC CBar 2 to 1 Narrow (True Type).
8) Select OK.
You'll need a bar code wand to read the bar code labels. Call 800-4247512 for details.
Daily Startup
To start the program, select the Library Wizard icon within the EPES
Software Group of your Windows Program Manager.
8
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Enter your ID: SYS
Password: PASSWORD
This is the ID and Password for the System Administrator. This person
has complete access to every option in the program. He/she can also add
new users and assign the rights for those users. See the 'Administrator
Menu' options.
This was the System Administrator ID and Password originally assigned to
the program. Use the 'Change Password' option under the Utilities Menu
to make any changes.
For student using the program, enter the following:
ID: PAT
Password: PASSWORD

This is the ID and Password for Patrons. It permits students to view
information on the screen that is needed, but not all information. It
also prevents them from adding or deleting information.
Master Menu
File
Edit
Commands
Administrator

Output

Window

Utilities

Help

Each option on the Master Menu is a chapter in this manual. To locate
information quickly, look at the title of each page.
Within each chapter, the items under each Master Menu option are
explained in order from top to bottom. Use the Find option below to look
up key words.
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A Quick Overview of the Program
• Change Password for System Administrator so you have total control of
what happens with your system. Be sure you keep this password in a
safe place. (Chapter 10)
•

Under the Utilities Menu, select "Program Preferences". Set up your
checkout information. (Chapter 8)

•

Add Teacher information. (Chapter 3)

•

Add Patron information. (Chapter 3)

•

Add library book information.(Chapter 3)

•

Check Books Out. (Chapter 3)

•

Check Books In. (Chapter 3)

•

Print Reports. (Chapter 6)
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Chapter 2: Getting Around in the Program
Using the Keyboard or Mouse
You can use the keyboard or mouse with the program. Keyboard short-cuts
can often save you a lot of time. For example, you can press [Ctrl+A]
while viewing information on the screen to add a new entry. Press
[Ctrl+S] when you've finished to save your work.
With the click of a button, a mouse can accomplish the equivalent of a
single keystroke or many keystrokes on the keyboard.
To select an item with the mouse, move the mouse pointer over the
desired item. Click the left mouse button on the desired item.

Moving Around the Screen
Keyboard
Use the [Tab] key, [Down Arrow] or [Right Arrow] keys to move to the
next item on the screen.
Use the [Shift+Tab] key, [Up Arrow] or [Left Arrow] keys to move to the
previous item on the screen.
Mouse
When adding or editing information on the screen, you can move your
cursor to an item simply by clicking on it with the left mouse button.
You can change the entire contents of an item by highlighting it with
the mouse. After the cursor is placed in the item, double click on the
left mouse button to highlight the entire contents. Then start typing.
Popup Screens and Lists
Sometimes it's hard to remember what to enter in a particular field. To
simplify your data entry, you can select a popup list while adding or
editing some information.
For example, suppose you were entering a Patron ID number. When you come
to the Patron ID field, press [F5]. A list of names will appear in a
scrolling list. Move your cursor to the column labeled Patron Name.
Begin typing the first few letters of the patrons name. When you see the
name, highlight it and press <Enter> to select it.
Adding or Editing from a Popup List
Sometimes when you have a popup list on the screen, the information
you're looking for has not been entered or is not correct.
11
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To add additional information while viewing the popup list, press
[Ctrl+A].
To edit the information highlighted in the popup list, press [Ctrl+E].
When you've finished adding or editing the information, press [Ctrl+S]
twice to save your information.
The ToolBar Menu
When you want to Add, Edit, or View information on the screen, you'll
select one of the options under the File Menu.
At the top of the screen, just under the Master Menu, the ToolBar Menu
will appear.
Each option is represented in a small box with a written description
underneath it. Use these options to Add, Edit, or View information on
the screen. To select an option, click on it with the mouse. There are
15 selections to choose from:
First Prev Next Last Add Edit Del Find List Filter Order By More Save
Cancel Close
First
Click this item to go to the first entry in the file.
Prev
Click this item to go to the previous entry in the file.
Next
Click this item to go to the next entry in the file.
Last
Click this item to go to the last entry in the file.
Add
Click this item to add a new entry. When you're done, click on "More" to
save this one and add another. Click on "Save" to quit adding and return
to view.
Edit
Click this item to edit the current information on the screen.
Del
Click this item to delete the current information on the screen.
Note: If you have a window at the bottom of the screen which has the
options "New Change Remove" listed, you'll have to use "Remove" to
delete all the detail items before you can delete the main information
on the screen.
12
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If you try to delete the information before using "Remove", a message
will appear and tell you it cannot delete the information.
Find
Use this option to find information already typed into the computer. A
Find Window will appear with the following options:
"Select Field to Search In:"
Press the space bar or click on the down arrow to the right to select
the specific field you want to look for. For example, Grade.
"Enter Value to Search For:"
Enter the information you want to search for. For example, 10.
"[X] Ignore Case
[ ] Exact Match Only"
If you want to find exactly what you type in, select Exact Match,
otherwise leave Ignore Case marked.
Find - Use this option to view the "First" entry for the information
you've just entered.
Browse - Use this option to choose from a list of entries that contain
the information you've just entered. Highlight the entry you want and
press <Enter> to view it.
Count - Use this option count how many times the information you typed
in is found in the file. A count will appear in the upper right hand
corner.
Close - Use this option to close the "Find Window".
List
Use this option to present multiple entries in a column and row format.
Normally you'll view about 20 items on the screen. To get the
information to fill the entire screen, click on the up arrow in the
upper right hand corner of the screen (Windows 3.x) or click on the
square (Windows 95).
To find an entry in the list, move the cursor to the field you want to
use. For example, name. Then, begin typing the first few letters of the
name. When you see the information you want, highlight it and press
<Enter>.
Note: The cursor will only go into columns where an index is defined.
You will not be able to use this option on every list column.
Filter
Use this option to limit the information you view on the screen.
The following example illustrates this option:
Suppose you want to look at all the checkout information for one book.
Select "Check Out" under the File Menu.
13
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Click on < Filter > with the mouse. A "Filter" Window will appear with
the following options:
"Select Field to Search In"
Press the space bar or click on the down arrow to the right to select
the specific field you want to look for. For example, Accession Number.
"Enter a Search Condition"
Press the space bar or click on the down arrow to the right to select
one of the following conditions:
Is Equal To
Is NOT Equal To
Is More Than
Is Less Than
Is Equal TO or More Than
Is Less Than or Equal To
"Enter value to Search For"
Enter the specific information you want to see. For example, to look at
all the checkout information for a book with Accession Number equal 1,
enter the number 1.
"[X] Ignore Case
[ ] Exact Match Only"
If you want to find exactly what you type in, select Exact Match,
otherwise leave Ignore Case marked.
Set - Use this option to set your filter. A message will appear in the
upper right hand corner telling you how many records met your criteria.
Once you close the Filter Window, you'll only be able to view the
information on the screen that met the criteria you typed in. In our
example, you'd only be able to view checkout entries for accession
number 1.
The Filter box on the ToolBar Menu will have a check in it. This
indicates a filter is set.
Clear - Use this option to clear the filter so you can view all records
on the screen for the file you've selected. You can also do this same
thing by selecting the "Clear Filter" option under the Commands Menu.

Close - Use this option to close the "Filter Window".
Setting Multiple Filters
If you already have a filter set and select the filter option again, the
following message will appear:
"A filter is in effect. Only records that match the current filter AND
the new filter criteria will be found. Clear Filter?"
14

Chapter 2: Getting Around

Yes - Use this option to erase the current filter.
No - Use this option to keep the existing filter in tact and add
another filtering condition to it.
For example, we originally set a filter to look at only checkout
information for accession number 1. You could now add a filter for a
patron id number. Then, the only checkout information you'd view would
be the book with accession number 1 and the patron ID number you just
entered.
Cancel - Use this option to exit and leave the existing filter in
place.
Order By
Use this option to select the order in which information is presented on
the screen. To set the order:
1) Highlight the box under "Order By".
2) Press the spacebar or click on the arrow to the right of the box to
show a list of fields.
3) Select the field which determines the order the information will be
presented on the screen.
4) By default, the order will be Ascending (from lowest to highest). If
you want the order to be Descending (highest to lowest), click on the
down arrow box to the right of "Order By:".
To change the order back to Ascending, click on the Up Arrow to the
right of "Order By:"
More
Click this item when you've finished adding an entry and want to add
another one. The current entry will be saved and a new screen will
appear.
Save
Click this item to save the information you've just added or edited.
You'll then return to view mode.
Cancel
Click this item to close what you're doing without saving the
information.
Close
Click this item to close the file you've selected and clear the screen.
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Chapter 3: File Menu
Library Books
Use this file to enter information about your library books.
Accession No: Each book is assigned a unique accession number as it is
purchased. This is normally a whole number like 1,2,3 etc. However,
story collections, collected biographies, or books that have more than
three related subjects may contain a decimal number.
When the computer does a book count, it only looks at whole numbers. The
decimal numbers are considered subsets of another book. Let's suppose
you have a book on Presidents of the United States and it's accession
number is 201. You want to put in two additional entries using a
Subtitle of Lincoln and Washington. These two entries would have an
accession number of 201.1 and 201.2 respectively.
The only difference in these last two entries is that the subtitle
Lincoln and Washington would be typed in. (This is the purpose of the
Subtitle line. Subtitles may not be used on normal whole number
accession entries.)
Section: If you want to designate some
special section for grouping purposes,
This code, REF, is used by the program
may also develop your own codes to use

area(s) of your library as a
enter a three digit code here.
to designate reference books. You
in other parts of the library.

Call Num: Enter the books classification number.
Type Media: This field enables you to have a card catalog and
circulation system for every type of media in your library.
Enter a one digit media
B=Books, A=Audiovisual,
By default the letter B
books. You may use any

code. For example, you might use the following:
C=Cassettes, M=Magazines, V=Videos.
is inserted into this field. This stands for
other letters to identify other types of media.

To globally enter a letter for your type media (for any range of
accession numbers,) see the Change Type Media option under the Utilities
Books option.
Be consistent in the information you enter. Then, when you run your
reports, you can include only the type of media you want printed. This
allows you to check in/out and report on all types of media in your
library from one main source.
In/Out: Press <Enter>. The computer automatically assumes the book is
In. (Press the letter O if it's out.)
16
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Author: Enter the Author's name, last name first.
Call Auth: Enter the first three letters of the authors last name.
ISBN No: Enter the ISBN number.
Title: Enter the title of the book.
SubTitle: Enter a subtitle if this is a second entry of a story
collection or collected biography. This means that the accession number
is a decimal number. See the discussion under Accession Numbers above.
You cannot use the subtitle for a whole number accession entry. The
program will stop you and tell you to change it.
Publisher: Enter the name of the publisher.
Place: Enter the place of publishing. For example, New York.
Copyright: Enter the copyright year for the book.
Pages: Enter the number of pages in the book.
Comment: Enter comments as needed. For example, Illustrated by Pat
Anderson. This comment will show up on the catalog cards!
Summary: Enter a brief summary of the book. The program will
automatically wrap around to the second line like a word processor.
Purchased: Enter the date the book was purchased.
Cost: Enter the cost of the book.
Funds: Enter a code to identify the type of funds used to purchase the
book. This may be especially helpful with federal funds.
Source: Enter the source where you purchased the book.
Flagged: Enter the date the book was flagged (not discarded). This means
the book is not accounted for.
Whocheck: Who can check this book out. By default the letter "A" is
automatically entered. This means all patrons may check out this book.
If the book does not contain the letter A, only faculty members will be
able to check out the book.
Discarded: Enter the date the book was discarded.
Why Disc: Enter a brief description of why the book was discarded. For
example: Lost.
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[ ] Print Barcode Label: (See Barcode Labels for Books under the Output
Menu). This option allows you to print bar codes for only those books
you mark. To print a barcode for this book, mark this box [X]. To
mark/unmark this box, press [Alt+M].
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Related Subjects Browse (Library Books)
This window appears in the lower left hand corner of the library books
screen. Use these five options to select and browse your library by
related subject: Select, First, Next , Prev, and Last.
To select a related subject from the list and browse:
a) Click on the related subject list so the cursor is active in the
related subject browse window. Begin typing in the related subject
you're looking for. When you see the subject you're looking for,
highlight it.
b) Click on 'Select' with the mouse. The number of books in the
library containing this related subject will appear in a window in the
upper right hand corner.
c) Click on First, Next, Prev or Last to view books in the library that
contain the related subject you've selected.
d) Follow steps a-c above to select another related subject.
Note: Use the Bibliography Report under the Books option of the Output
Menu to view or print all books in the library that have the same
related subject.
Adding Related Subjects (Library Books)
Use the following options to add related subjects to your books.
New
Use New to add additional related subjects for this book. When the
related subjects field appears on the screen, press [F5] to select from
a popup list of related subjects. Once the popup list is on the screen,
begin typing the first few letters for the related subject you want to
enter. When you see the related subject you want, make sure it's
highlighted and press <Enter>.
If the related subject does not exist, press <Ctrl+A> to add a new
related subject title. When you're finished adding a related subject
title, press <Ctrl+S> twice to save the information. Once the new
related subject title is saved, it will be highlighted. Press <Enter>
to add this related subject to the book you're entering.
Change
Highlight a related subject in the list in the lower right hand corner
of the library books screen and select Change to Edit the related
subject title.
Remove
Highlight a related subject and select Remove to erase the related
subject. Selecting Remove will ask if the currently selected record in
19
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the list should be deleted. If the response to this question is Yes, the
item will be removed from the list. If no information is displayed in
the list the Change and Remove push buttons will be disabled.
Add Decimal Accession (Library Books)
Click on the "Add Decimal Accession" button in the library books screen
to automatically add a decimal accession number entry for the current
book on the screen.
A decimal accession number indicates that the entry is part of a story
collection or a collected biography.
For example, suppose accession number 100 was a book about "Presidents
of the United States".
The book with Accession number 100.01 would be identical to the book
with accession number 100, except the entry with the decimal accession
number can use the subtitle field to provide additional clarification.
For example, the subtitle might be "George Washington"
The decimal accession number could also have different related subjects.
Subtitles may not be used on normal whole number accession entries. The
purpose of the subtitle line is to add additional information about a
story collection or collected biography.
Check Out Books
Use this file to check out books.
Accession: Enter the Accession number of the book by hand or bar code
wand.
Patron Id: Enter the Patrons ID number by hand or by bar code wand.
These two items are all that is required to check out a book. The
computer will automatically fill in the Teacher, Date Out, and Date Due
(based on the number of days you set up).
The computer will automatically your Library Book File to Out and add
one book in the Patron File.
If the patron has already reached the limit on the number of books
allowed to check out, the computer will warn you, but will allow you
continue.
If the patron is restricted, the computer will tell you and will not
allow the book to be checked out.
There are four shortcut options to use with the book currently on the
screen.
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F4 Re-Check this Book
Press the F4 function key to recheck the book currently on the screen.
The date in will automatically be entered in the current entry. A new
entry will be added to the end of the checkout book file.
F6 Check in this Book
Press the F6 function key to check in the current book. Today's date
will automatically be entered for you.
Use the Check In Books option under the File Menu to check in multiple
books at the same time.
F8 Credit for Fine Paid
Press the F8 function key to credit the current book fine, if any, as
paid.
F10 Calculate Current Fine
Press the F10 function key to calculate the current fine for this book.
Use the "Calculate All Book Fines" option under the Utility Menu Books
options to calculate the current fine for all books.
Check In Books
Use this screen to check in multiple books at the same time.
Accession: Enter the accession number of the book to be checked in.
The program automatically:
a) Updates the Checkout information.
If the book was not found in the check out file, a message will tell you
it was not checked out. This message simply warns you to double check
your processes and procedures. If the book is to being checked back in,
evidently it was checked out at some point. The remaining steps below
will also be done.
b) The library book [In/Out] field is changed to In.
c) The number of books checked out by the patron is decreased by 1.
Patrons
Use this file to enter information about your patrons.
Patron ID:

Enter a unique ID number for the patron.

Patron: Enter the name of the patron, last name first.
Grade: Enter the grade of the patron.
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Teacher ID: The teacher information must have been entered before you
can enter information in this item. Press the <F5> to select from a
popup list.
Note: You'll probably want to use the patron's homeroom teacher here to
have someone to distribute overdue notices to.
If the patron is a Faculty member, press <Enter> to leave this item
blank.
Type Patron: Press <Enter> for a normal patron (Student).
Enter FAC for a faculty member.
Enter RES for a restricted patron. (This means a patron who cannot check
out a book!)
Note: When a book is checked out, the computer checks the information
under type patron to determine if a book may be checked out and for how
long.
Address: Enter the address of the patron.
City: Enter the city where the patron lives.
State: Enter the two digit abbreviation for the state.
Zipcode: Enter the zipcode for the patron.
Note: The computer automatically adds and subtracts the number of books
checked out by each patron.
[ ] Print Barcode Label: To print barcodes for only selected patrons,
mark this box [X]. Use [Alt+M] to mark/unmark this box
Print Office Clearance Notice (Patrons)
If a patron has no books out, click on this button to print a clearance
report for the main office when a student is leaving school.
If the student has books checked out, this button will be disabled. You
will not be able to print a clearance report. Check all books in for the
student and then return to the patron's screen to print the clearance
notice.
Teachers
Use this file to enter information about your teachers.
Teacher Id: Enter a unique ID Number for this teacher.
Tch Name: Enter the name of the teacher, last name first.
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Room Number: Enter the teacher's room number.

Related Subjects
Use this file to enter related subject titles for your books.
Related Subject Title: Enter a descriptive title for this related
subject.
Note: All related subject titles are all caps. This is to facilitate the
look up of related subjects from the library books screen.

Inventory
Use this file to enter information for your book inventory.
To do your inventory, use the following steps:
1) Use the Book Inventory option under Book Utilities of the Utilities
Menu to Mark all books in the library as Out.
2) Use the Inventory option under the File Menu to enter the accession
number of every book that is in the library.
3) Use the Book Inventory option under Book Utilities of the Utilities
Menu to Mark all books from inventory as In.
4) Use the Book Inventory option under Book Utilities of the Utilities
Menu to erase all accession numbers in the inventory file.
5) Print the report "Inventory List of Books Out" under Book Reports of
the Output Menu. This will print a list of all books that did not show
up during the inventory process.
Book Orders
Use this file to enter information about books you have reviewed and may
want to order. You'll enter the same information as you do in the
library books file with the exception, that you will not assign an
accession number until you have actually ordered and received the book.
Marc Records (Book Orders)
When you order books and receive the information on disk, use the MARC
Record option under the Utilities Menu to read the information into your
computer. This information is automatically posted to the Book Orders
file. If you told your book company the accession numbers to use for
these books, they will automatically be entered for you by the MARC
record option. If not, you must enter an accession number into the book
order entry before it can be posted to the books file.
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After reviewing the orders file, use the 'Post Book Orders' program
under Book Utilities of the Utilities Menu to post book orders to the
orders books file. This option will check to make sure no duplicate
accession numbers have been used. If there are duplicate accession
numbers, a list of books with duplicate accession numbers will be
displayed for you. The orders will NOT be posted until all duplicate
accession numbers have been corrected.
Close
Use this option to close the current file that is displayed on the
screen.
Printer Setup
Use this option to select a default printer or add/remove a printer
driver from your windows operating system. See your Windows operating
instructions for detailed information.
Exit
Use this option to exit the program.
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Chapter 4: Edit Menu
Use the following commands while adding or editing information on the
screen. (See note on how to highlight information below.)
Cut Ctrl+X
Select "Cut" from the Edit Menu or hold down the Ctrl key and press the
letter X to delete (Cut) highlighted information in a field on the
screen.
Copy Ctrl+C
Select "Copy" from the Edit Menu or hold down the Ctrl key and press the
letter C to copy highlighted information to the computer clip board.
Paste Ctrl+V
Select "Paste" from the Edit Menu or hold down the Ctrl key and press
the letter V to copy information copied onto the computer clip board
into the current field on the screen.
Note: To highlight information in a field on the screen:
Using the Keyboard:
1) Move the cursor to the first letter where you want to begin
highlighting.
2) Hold down the Shift key and press the right arrow key. You'll
actually see the information being highlighted on the screen.
3) Use the copy or cut command on the highlighted information.
Using the Mouse:
1) Move the mouse to the first letter where you want to begin
highlighting.
2) Click on the left mouse button and HOLD the button down.
3) Move your mouse to the right. You'll actually see the information
being highlighted on the screen.
4) Use Select the "Copy" or "Cut" command under the Edit Menu.

25

Chapter 5: Commands Menu

Chapter 5: Commands Menu
The Commands Menu is the pull down menu equivalent of the ToolBar Menu.
It shows the keyboard equivalent for most of the ToolBar Menu options.
For example, Ctrl+Home means hold down the Ctrl key and press the Home
key.
Top Ctrl+Home
Go to first entry in the file.
Bottom Ctrl+End
Go to the last entry in the file.
Next Ctrl+PgDn
Go to the next entry in the file.
Prev Ctrl+PgUp
Go to the previous entry in the file.
Add Ctrl+A
Add a new entry. When you're done, select "More" to save this one and
add another. Select "Save" to quit adding and return to view.
Edit Ctrl+E
Edit the current information on the screen.
Del Ctrl+D
Click this item to delete the current information on the screen.
Note: If you have a window at the bottom of the screen which has the
options "New Change Remove" listed, you'll have to use "Remove" to
delete all the detail items before you can delete the main information
on the screen.
If you try to delete the information before using "Remove", a message
will appear and tell you it cannot delete the information.
Browse Ctrl+B
(Same as List on ToolBar Menu)
Use this option to present multiple entries in a column and row format.
Normally you'll view about 20 items on the screen. To get the
information to fill the entire screen, click on the up arrow in the
upper right hand corner of the screen (Windows 3.x) or click on the
square (Windows 95).
To find an entry in the list, move the cursor to the field you want to
use. For example, name. Then, begin typing the first few letters of the
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name. When you see the information you want, highlight it and press
<Enter>.
Note: The cursor will only go into columns where an index is defined.
You will not be able to use this option on every list column.

Filter Ctrl+L
See details, page 16.
Find Ctrl+F
Use this option to find information already typed into the computer. A
Find Window will appear with the following options:
"Select Field to Search In:"
Press the space bar or click on the down arrow to the right to select
the specific field you want to look for. For example, Grade.
"Enter Value to Search For:"
Enter the information you want to search for. For example, 10.
"[X] Ignore Case
[ ] Exact Match Only"
If you want to find exactly what you type in, select Exact Match,
otherwise leave Ignore Case marked.
Find - Use this option to view the "First" entry for the information
you've just entered.
Browse - Use this option to choose from a list of entries that contain
the information you've just entered. Highlight the entry you want and
press <Enter> to view it.
Count - Use this option count how many times the information you typed
in is found in the file. A count will appear in the upper right hand
corner.
Close - Use this option to close the "Find Window".
Order
This option is similar to the "Order By:" option of the ToolBar Menu.
However, it brings up the "Change Viewing Order" window on the screen to
choose the field to order by and the direction.
To change the view order of the information on the screen:
a) Highlight the field to use in ordering the data on the screen.
b) Select "Ascending" or "Descending".
Clear Filter
Select this option to quickly clear all filters that have been set on
the data you are viewing. If no filters are set, this option is
disabled.
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More Ctrl+M
Use this option when you've finished adding an entry and want to add
another one. The current entry will be saved and a new screen will
appear.
Save Ctrl+S
Use this option to save the information you've just added or edited.
You'll then return to view mode.
Cancel
Use this option to quit adding or editing without saving any changes or
additions.
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Chapter 6: Output Menu (Reports)
This chapter explains how to select and print reports from the Output
Menu. This option is Not available if you are viewing information on the
screen. Close what you're doing and return to the Master Menu.
Using the Report Query Dialog
All reports, except Catalog Cards and Barcodes, use what is called a
"Report Query Dialog" to select the information to print. On these type
of reports,
you have a lot of flexibility in deciding what information to print and
in what order.
First, we'll explain the Report Query options. Then, we'll provide a
couple of specific examples to better help you understand this option.
Select your report from the "Output" option of the Master Menu.
Preview
Select this option to view the entire report on the screen.
Print
Select this option to print the entire report to your printer.
Done
Select this option to exit and return to the Master Menu.
Selecting Information to Include in the Report
Use the "Report Query" Window to build conditions about what data should
appear on your reports.
The following options are available in the "Report Query" Window.
Field List Box
The box in the upper left hand corner of the "Report Query" Window lists
all the fields you may select from in order to limit the information to
print out.
For example, do you want to limit the information you print out by
Accession number, Call Number, Author, etc.
Operator List Box
The box in the upper middle of the "Report Query" Window displays all
the comparison operator. These operators vary depending on what type of
information you select. All operators and their corresponding
descriptions are explained below.
*

Begins With
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Finds records where the information recorded in the computer begins
with the first few letters/numbers you type in.
*

Is Equal To
Finds records where the information recorded in the computer equals
what you typed in.
*

Contains
Finds records where the information recorded in the computer
contains the letters/numbers you type in anywhere in the field you've
selected.
For example, suppose you want to print books by a specific author, but
can't remember all of the name. You do remember that the authors name
does includes the letters ander (Anderson). Type in this information.
All author names
which have Ander in their name at the beginning, end, or middle will be
selected.
*

Ends With
Finds records where the information recorded in the computer ends
with the letters/numbers you typed in.
For example, you know a author's name ends in the word son, but can't
remember the rest of the name. Select Author, < Ends with >, and type
son. All authors whose name ends with son will be selected.
SELECTING INFORMATION TO INCLUDE IN THE
*

Is In List
Finds records where the information recorded in the computer is
contained in the list of information you typed in. Remember to separate
each item by a comma.
For example, suppose you want a list of all books whose call number
begins with 589, 598, or 599. Select Call Num,
< Is In List >, and type in: 589,598,599 Remember, the comma separates
the three call number entries.
*

Is More Than
Finds records where the information recorded in the computer is
greater than the value you typed in under the "Compare To" box.
Suppose you want to a report of all fines that are more than $1.00.
Select one of the overdue book reports. Select Amt Fine, <Is More Than>,
and type in: 1
*

Is Less Than
Finds records where the information already recorded in the
computer is less than the value you typed in under the "Compare To" box.
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Suppose you want to a report of all fines that are less than $2.00.
Select one of the overdue book reports. Select Amt Fine, <Is Less Than>,
and type in: 2
*

Is Between
Finds records where the information recorded in the computer is
between values you typed in under the "Compare To" box. Remember to
separate the values you type in by a comma.
For example, to limit a report between Sep 1, 1998 and Sep 30, 1998,
you'd select Date Due, < Is Between >, and type: 09/01/98,09/30/98
Remember the comma between the items.
*

Year Is
Finds records where the year recorded in the computer equals the
year you typed in.
*

Month Is
Finds records where the month recorded in the computer equals the
month you selected from the popup list under the "Compare To" box.
For example, suppose you wanted a list of all books checked out in
September. Select one of the checkout reports. Select Date Out, < Month
Is >, and select 'September' from the popup list.
*
Day Is
Finds records where the day recorded in the computer equals the day you
selected from the popup list under the "Compare To" box.
For example, suppose you wanted a list of all books checked out on
Monday. Select one of the checkout reports. Select Date Out, < Day Is >,
and select 'Monday' from the popup list.
Note: Most of the time you'll use
< Year Is >, < Month Is >, and < Day Is > together. Don't forget, to
select < Accept Condition> after each selection.
*

Is Yes
Finds records where the information recorded in the computer equals
true. (.T.)
*

Is No
Finds records where the information recorded in the computer equals
false. (.F.)
Compare to Box
This box is where you type in the information to use in selecting your
report. In some cases, you'll enter more than one item. You must
separate multiple items with a comma. See the < Is In List > example
above.
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[X] Ignore Case
This option tells the computer to ignore upper and lower case for
anything you typed in under the "Compare To" box. Normally, you'll leave
this box checked. It makes it easier to select your information.
[ ] Negate
Select this box to make the condition the opposite of what you've just
typed in. Normally, you'll leave this box blank.
For example, if you wanted all books checked out in May and then marked
this box, your report would contain all books NOT checked out in May.
(See < Year Is > example above.)
[Accept Condition]
This option tells the computer to Accept what you've typed in or
selected. The condition appears in the "Query Conditions" box in a
descriptive English-like phrase.
[ ] Output Order
Use this option to select the order in which to print your report. In
some cases the option will already be marked [X]. This means the report
has already been set up with a pre-determined sequence which you cannot
alter.
Query Conditions Box
Displays the currently selected conditions in a descriptive English-like
phrase.
[Add OR]
Use this option to add an "OR" condition when selecting your report.
For example, suppose you wanted a list of all books checked out in
August OR September. To do this:
1) Select one of the checkout reports. Select Date Out, < Month Is >,
and select "August" from the popup list.
2) Click on < Accept Condition >.
3) Next, click on < Add Or >.
4) Select Date Out, Month Is, and select "September".
5) Click on < Accept Condition >.
[Remove]
To remove one of the conditions you've entered in selecting your report,
highlight the condition (English-like phrase) in the Query Conditions
box and select [Remove].
[Clear All]
Select [Clear All] to removes all conditions from the Query Conditions
box.
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[Save]
Use this option to save your Report, with Query conditions, for future
use.
When < Save > is selected you will be asked to enter a meaningful name
for the report you've created.
[Retrieve]
Use this option to retrieve previously saved reports and re-use or edit
them.
[Printer]
This option brings up the Windows Printer dialog to select a printer for
your report or label.
[ ] Print Setup Page Not used.
[Print]
Select this option to print the report to your printer.
[Preview]
Use this option to view your report on the computer screen. While
viewing the information on the screen, use the control buttons on the
right and the scroll bars of the report window to look over your report:
* Next
Shows the next page of your report.
* Previous
Shows the previous page of your report.
* Page
Use this to select the page to go to.
* Zoom In
Shows specific parts of your report in close up view.
* Zoom Out
Shows the entire page of your report.
* OK
Select < OK > to exit the screen report.
[Done]
Select this option to exit and return to the Master Menu.
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Book Reports
Accession Record
This report prints an Accession record report of the books in your
library.
Discarded Books
This report prints a list of books discarded
Flagged Books
Use this report to print a list of books that have been flagged. If
they are returned, don't forget to update the Flagged Date field. If
they are permanently lost, update the Discarded Date field.
Related Subjects - Bibliography
Use this report to print a list of books by related subject.
Shelf List Report
Use this report to print a shelf list report of books in your library.
Inventory List of Books Out
Use this report to print a list of books still out after completing
your inventory.
Book Orders
Use this report to order books by author or title.
Checkout Reports
Overdue by Teachers
Use this report to print a list of overdue books by grade and teacher.
Overdue by Patron by Grade
Use this report to print a list of overdue books by grade and patron.
Overdue 1/3 Page
Use this report to print a 1/3 page overdue report to give to patrons.
Overdue Patrons Alphabetically
Use this report to print a list of overdue books patron name.
Books Out by Grade and Patron
Use this report to print a list of books out by grade and teacher.
Summary of Books Checked Out by Date
Use this report to print a list of books checked out by date.
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Summary of Books Checked In by Date
Use this report to print a list of books checked in by date.
Circulation Reports
Count of Books by Date
Use this report to print a count of books checked out by date.
Count of Books by Accession Number
Use this report to print a count of books checked out by accession
number.
Patron Reports
Patrons by Grade and Teacher
Use this report to print a list of patrons by grade and teacher.
Patron Address Information
Use this report to print a list of patron address information.
Books Read by Patrons
Use this report to print a list of books read by each patron. It
includes the title of the book, number of pages in book, total pages,
and total books read.
Teachers
Use this report to print a list of teachers and their room number.
Card Labels
Select your type printer. Then, select the card labels you want
printed.
Spine Labels
Select your type printer. Then, select the spine labels you want
printed.
Catalog Cards
Select this option to print catalog cards for your books.
1) Mark the box for the cards you want printed: Shelf List, Author,
Title, and/or Related Subject Cards.
2) Select the type printer: Dot Matrix or Laser.
3) Enter the lowest and highest accession number to use in selecting
the cards to print.
4) Mark the box [X] if decimal accession cards are to be printed.
Barcode Labels
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Books
Use this option to print barcode labels for your books.
1) Select the type printer: Laser or Dot Matrix.
2) Enter the lowest and highest accession number to use in selecting
the book barcode labels to print.
3) [ ] Print Marked Books only.
If you want to print only those individual books you marked in the books
file, mark this box [X]. This will override the information entered in
step 2 above. After these barcodes are printed, the books will
automatically be unmarked.
Patrons
Use this option to print barcode labels for patrons.
1) Select the type printer: Laser or Dot Matrix.
2) Decide how you want to select patrons: Select bar codes by: Patron
ID, Grade, Patron Name, or Marked Patron File Entries.
Note: If you select Marked Patron Entries, then only those individual
patrons marked in the patron file will be printed.
3) Enter the lowest and highest value to use in selecting the patron
barcode labels to print. This is based upon the item you selected in
step 2 above. For example,
From Grade: 10
From Name: Beasley, Rae
To Grade: 10
To Name: Beasley, Rae

Report Writer
This chapter explains how to enter your report parameters for the
reports utilizing the R&R Report Writer.
For our example we are using the Outstanding Check report. All reports
use the same method to include/exclude data and select sort sequences.
Once you have selected the report you will see the “Report Query”
screen. The “Report Selected” is preset and cannot be changed. You can
enter whatever information you desire on the “Report Title” line. This
information will print on the top of each page of your report.
The 3 items you will need to enter to generate the report (if you choose
to not enter any parameters, a report of all data in the file will be
printed or displayed.
The items required to limit reporting are:
Select Fields to Limit:
The information shown under this column are the fields that can be use
to limit data. These are not necessarily the only information that
prints on the report but these are the only fields you can select to
36

Chapter 6: Output Menu (Reports)

inclue/exclude information. You cannot eliminate any of these fields
from the report but you can limit the data printed using this field.
Enter Lowest/Highest Values to include on Report:
These 2 columns are where you will enter the information that you want
to see on the report. In our example below we will explain its usage.
Enter Sort Order:
This column can be used to specify in what order you want the report to
print.
Example:
On the Outstanding Checks report the fields shown under the “Select
Fields to Limit” column are:
Check Number
Date
Total Amount
Payee
GL Account
Notice the box to the left of the “Select Fields” column.
If you want to use this field to enter your selection criteria, you must
first click on the box to the left to indicate your usage of this field.
Ex: If we wanted to print a list of Outstanding Checks for the month of
July, 2001 we would first click on the box to the left of “Date” then we
would tab over to the “From” field under the “Enter Lowest/Highest
value”
column and we would enter 07/01/2001, then we would tab to the “To”
field under the “Enter Lowest/Highest value” column and we would enter
07/31/2001 then we would click on [Print]. This would produce a report
that shows all outstanding checks from July 1 thru July 31, 2001.
There is no limit to the number of fields you can use with your
selection criteria. If you wanted to print outstanding checks for July
2001 that were written to a specific Vendor (for example Walmart), you
would enter the same information as above, plus you would check the box
to the left of “Payee”, tab to “From: under the “Enter Lowest/Highest”
and enter “WALM”, or whatever Vendor Code you setup for Walmart, then
tab to the “To” field under the “Enter Lowest/Highest? column and enter
“WALM”. This would produce a report of all outstanding checks from
7/1/2001 thru 7/31/2001 that were written to Walmart.
Enter Sort Order 1,2,3
This column is used to sort the report in whatever sequence you prefer.
Some of the reports have the first sort order predefined. You cannot
change the predefined sort orders but you can indicate what sequence you
want the secondary sort order in.
Ex: Lets produce a report of Outstanding checks that are between
$100.00 and $150.00 and we want them in check number and date sequence.
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First you would click on the box to the left of “Total Amount”, then tab
over to the “From” field, enter 100.00, tab to the “To” field, enter
150.00. Now you’re ready to specify your sort order. Notice that the
“Check No” field is already defaulted as the first sort sequence. You
would simply click on the box to the right of “Date” under the “Enter
Sort Order” column and you would put a 2 in this box.
These parameters will produce a report of all outstanding checks with a
total amount of $100.00 thru $150.00 and they would be sorted in check
number and date sequence with check number being the highest sort
sequence.
All the reports using the R&R Report Writer query are developed in this same manner. After you click on “Print´ the report will be
displayed on the screen. From that display you have the option to print the report or exit back to your original screen. Once you enter
data into a report query that data will be shown the next time you access this same report query screen. To start a new query you will
need to click on the “Clear Report” option on the bottom of the screen to remove the previously defined query options.
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Chapter 7: Window Menu
This chapter explains the Window Menu options. You'll learn how to move
a window on the screen, change it's size, and select another window on
the screen when more than one is being used.
Move
Keyboard
Press [Ctrl+F7] to move the front most window on the screen to a
different position. Use the arrow keys to move the window up, down, left
or right. Press [Enter] when you're done.
Mouse
Click on the very top portion of the screen with the left mouse button.
Hold the mouse button down and drag the screen to a different location
on the screen. Let up on the mouse button.
Size
Keyboard
Press [Ctrl+F8] to re-size a window on the screen. Use the arrow keys to
adjust the size of the window. Press [Enter] when you're done.
Mouse
Click on the very outside edges of the screen with the left mouse
button. Hold the mouse button down and drag the screen, up, down, left,
or right to change it's size. Let up on the mouse button when you're
done.
Maximize
Keyboard
Use this option with list windows, where multiple records are on the
screen. Press [Ctrl+F10] to make the current window on the screen it's
maximum size.
Mouse
Click on the up mark (or the box in Windows 95) in the upper right hand
corner of the window to make it cover the full screen.
Minimize
Keyboard
Press [Ctrl+F9] to make the current window on the screen as small as
possible.
Mouse
Click on the Up/down marker in the upper right hand corner of the List
Window to return to normal size.
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Note: Click on the second row of your screen. The top row of your screen
contains the name of the program. The second row (to click on) contains
the Master Menu options File, Edit, etc.
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Selecting Different Windows on the Screen
The name of all the screens that have been opened will be listed under
the Minimize Command. Multiple windows (files) may be opened at one
time.
To make a window current, click on the name of it with the mouse (under
the Windows Menu) or click on the window itself on the screen.
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Rebuild Indexes
Use this option when you've had a computer problem or power failure to
rebuild the indexes of your data file(s).
To mark one file to be re-indexed, use the arrow keys to highlight the
file and press [Enter] or double click on it with the mouse. Notice the
arrow markers >> to the left of the file name.
Mark All
Press [Alt+A] or click on < Mark All > to mark all data files to be
reindexed.
Clear Marks
Press [Alt+M] or click on
< Clear Marks > to unmark all data files.
Invert
Press [Alt+I] or click on < Invert > to change all marked files to
unmarked and vice versa.
Select < OK > to reindex the data file(s) or < Cancel > to return to the
Master Menu.
Erase Deleted Records
Use this option to erase all deleted entries in a file.
When you use the Delete option [Ctrl+D], the entry on the screen is
marked for deletion and you no longer see it on the screen. However, it
is physically still on your hard disk. This option physically erases all
entries marked for deletion. They'll be gone forever!
To mark a file (in order to erase deleted records), use the arrow keys
to highlight it and press [Enter] or double click on the file with the
mouse. Notice the arrow markers >> to the left of the file name.
Mark All
Press [Alt+A] or click on < Mark All > to mark all data files for
deleting records.
Clear Marks
Press [Alt+M] or click on < Clear Marks > to unmark all data files.
Invert
Press [Alt+I] or click on < Invert > to change unmarked files to marked
and
vice versa.
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Select < OK > to erase the deleted records in the selected data file(s)
or < Cancel > to return to the Master Menu.
Update File Structure
Use this option to update the structure of a data file when you receive
updates to the program. You'll receive instructions with your update on
which file(s) to select.
Press the [Spacebar] and use the arrow keys to highlight the file or
click the mouse on the down arrow to the right of the filename box and
click the data file to be updated.
Select < OK > to update the file or < Cancel > to return to the Master
Menu.
Program Preferences
Use this screen to enter your checkout information. This includes:
1) How many books a patron may check out at one time.
2) How many days a book may be checked out by a patron.
3) How much a book fine will cost per day when overdue.
4) How many days a reference book may be checked out.
5) How many day a Faculty member may check out a book.
6) How may books a faculty member may check out at one time.
Select the type printer you'll use for printing reports in the Format
box.
[1] = Laser Printer
[2] = Dot Matrix Printer
Select your computer's Printer Port. Normally, this is LPT1. When in
doubt, select this option.
Tell the computer whether to turn the Century on.
When marked [X], the reports and screen will show dates in the format:
09/01/1998.
When not marked [ ], the reports and screen will show dates in the
format: 09/01/98.
For the Year 2000, you will have to have the century box marked [X].
BOOK UTILITIES
Book Utilities
Calculate All Book Fines
Use this option to calculate and update all current book fines. If a
student fails to turn in a book, this will increment each day based upon
the fine per day information you've entered in your Program Preferences.
Zero Out All Book Fines
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Use this option to change all fines to zero in the checkout file. It
also changes the date paid to date in.
Post Orders To Books
Select OK to post books from the order file to the library book file.
An entry in the order's file must have an accession number entered in
order to be posted to the library book file.
Marc Records
This program supports the MARC microlif format (1987).
If you ordered MARC records on disk, this information is automatically
entered into the orders file for you. When ordering books, give the
company the beginning accession number you want it to use. This should
be the next number in sequence that has not been used. The company
should be able to automatically include an accession number for each
book purchased. This will save you a lot of data entry time.
You should review all the entries in the order's file that you want to
be posted to the library books file. Make sure the information is
correct.
This program will first check to make sure there are no duplicate
accession numbers in the order file, i.e., an accession number in the
book file can only be used once. If there is a duplication, the program
will show you a list of duplicate accession numbers. No orders will be
posted to the library books file, until you've corrected any duplicate
accession numbers.
Recalculate Patron Books Out
This option updates the number of books a patron has checked out. It
also updates the library books file to match this same book count.
Erase Discarded Books
Be sure no one else is using the system before running this option.
Select OK to permanently erase any books that contain a discarded date.
Select Cancel to exit and return to the Master Menu.
Erase Checkout Information
This option permanently erases checkout information. Be sure you have a
backup of your data prior to using this option.
If books are still out, the information will not be erased.
If you want to erase information where the book has been returned but
the fine has not been paid, mark the Erase Checkout Information box
[X]. This checkout information will be erased. You will not collect the
fines due.
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To mark/unmark the Erase Checkout Information box, click on it with the
mouse or press the spacebar.
Book Inventory
To do your inventory, use the following steps:
1) Use the Book Inventory option under Book Utilities of the Utilities
Menu to Mark all books in the library as Out.
2) Use the Inventory data file under the File Menu to enter the
accession number of every book that is in the library.
3) Use the Book Inventory option under Book Utilities of the Utilities
Menu to Mark all books from inventory as In.
4) Use the Book Inventory option under Book Utilities of the Utilities
Menu to erase all accession numbers in the inventory file.
5) Print the report "Inventory List of Books Out" under Book Reports of
the Output Menu. This will print a list of all books that did not show
up during the inventory process.
BOOK UTILITIES (continued)
Automatically Change Date Due
This option automatically changes the date due for a specific date.
Enter the current date. For example: 09/01/98
Enter the new date these books are to be due. For example: 09/05/98
Change Type Media
Use this option to globally change the Type of Media field in the
library books file for the range of accession numbers entered. For
example, you could change all books with accession numbers between 500
and 725 to be labeled as M for Magazine.
Patron Utilities
Copy Patrons To Floppy
Use this option to copy student information for students moving to
another building in the district.
Place a blank formatted floppy diskette in your computer. Tell the
program which drive you placed the diskette in (A or B).
Enter the grade of the students you want to copy.
For example, if students are moving from grade 9 in a Junior High
building to grade 10 in a High School building, you'd copy all the grade
9 students.

45

Chapter 8: Utilities Menu

Once the information is copied, you may erase the grade 9 students and
promote the remaining students using the Patron Utility options under
the Utilities Menu.
Copy Patrons From Floppy
Use this option to copy student information for students moving into
your building from another building in the district.
Place the diskette in your computer.
placed the diskette in (A or B).

Tell the program which drive you

Once the information is copied, you may erase the grade 9 students and
promote the remaining students using the Patron Utility options under
the Utilities Menu.
After you copy the information from the floppy disk, use the Patron
Utilities under the Utilities Menu to erase the students leaving your
building. Then promote the remaining students to the next grade.
Increment Patron Grade Level
Select OK to add or subtract one grade level for each of your patrons.
Select Cancel to exit and return to the Master Menu.
Delete Patrons In One Grade
Use this option to delete one grade of students leaving your building.
Be sure to copy these students to a floppy diskette, if they are going
to another building in your district. This will save the librarian
there a lot of time.
When you're ready, enter the grade you want to delete.
Change Password
This screen will allow you to change your password. You must first enter
the current password. Then you can enter your new password. You must
then enter the new password again to insure accuracy.
Backup/Restore
Use this option to backup and restore your library information to a
floppy disk(s) or to the backup directory of your harddisk.
You must tell the program whether to backup or restore your data.
You must tell the program where the data is, i.e., floppy drive A or B,
or on your harddisk.
Export File
Use this option to copy information from your computer to a floppy disk
drive. For your information, the data will be copied using the ASCII
format.
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Follow the steps on the screen:
1) Select the file that you want to copy to a floppy diskette.
arrow keys or mouse.

Use the

2) Put a blank formatted diskette in floppy drive A or B.
3) Enter the disk drive and path for your data.
A:MYFILE.TXT

For example:

4) If you do not want to copy the entire contents of the file to a
floppy diskette, select Yes when prompted "Do you want to set a filter?"
(See the example below.)
You must then select the field for the program to look at to determine
what information to copy. For example, if you wanted to copy students in
grade 10:
You'd select the Patron file.
When the "Filter" window appears you'd select "Grade" as the "Field to
Search In".
Next, select 'Equals to".

Enter the grade: 10

Click on "Set". The program will tell you how many matches (patrons)
were selected. Click on "Close".
5) Select the fields to export Window
At this point you may copy any or all of the fields in the selected
file.
Click on "Select All" to copy all the information to a floppy diskette.
All the fields in the box on the left will appear in the box on the
right. The box to the right shows all the data fields to be copied.
To select individual fields, double click on a field in the box to the
left. It will appear in the box on the right.
NOTE: If you only want to copy certain fields, it's very important that
you copy them in the order you want them to be written on the disk. If
another program has some of the same information (and can import data),
be sure you select the fields you want in the order you want.
If you make a mistake or change your mind, use the "Deselect All" to
remove all fields to be copied or the "Deselect" option to remove one
field from the box on the right.
Select OK to copy the selected information to the floppy diskette.
Select Cancel to exit and return to the Master Menu.
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Import File
Use this option to copy information from a floppy diskette to your
computer. For your information, the data will be copied using the ASCII
format.
Follow the steps on the screen:
1) Select the file that you want to copy into from the floppy diskette.
2) Put the data diskette in the disk drive.
3) Enter the disk drive and path for your data file.
A:MYFILE.TXT

For example:

4) Select the Fields to Import Window
At this point you must tell the computer which fields are on the floppy
disk file and the sequence in which those fields were written to the
floppy diskette.
Click on "Select All" to copy all the information in the file from the
floppy diskette. All the fields in the box on the left will appear in
the box on the right. The box to the right shows all the data fields to
be copied to your computer from the floppy diskette.
To select individual fields, double click on a field in the box to the
left. It will appear in the box on the right.
NOTE: If you only want to copy certain fields, it's very important that
you tell the program the order in which the fields were written onto the
disk.
If you make a mistake or change your mind, use the "Deselect All" to
remove all fields to be copied or the "Deselect" option to remove one
field from the box on the right.
Select OK to copy the selected information from the floppy diskette to
your computer.
Select Cancel to exit and return to the Master Menu.
Registration Form
Use this screen to print a copy of your registration form.
Upon receipt of your registration form and payment, you are entitled to
180 days of Free Technical Support.
Call Technical support from 9 am to 4 pm CST at 1-918-366-4454.
Convert Data From Dos
Use this option to read all the data entered into your old library book
program into the current windows library wizard program.
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Enter the drive and path where your old library book files are kept on
your computer. The default is C:\BOOKS.
Marc Records
Use this program to copy library books stored in Microlif (1987) Marc
record format to your orders file.
The name of the file on your floppy diskette will be: IBM.FIL
Select the Floppy Disk Drive where the MARC record data disk is located
(A or B).
This information will be added to your Book Orders file for you to
review in detail before posting to your books file.
Delete Saved Report
Use this option to delete reports you have previously saved. Use the
buttons at the bottom of the screen to get the report you want to delete
on the screen. Then, click on 'Delete'.
If there are no saved reports, a message will appear in the upper right
hand corner telling you so.
Verify Teacher ID in Checkout
This option checks and verifies the Teacher ID in the Checkout File. If
there is not a Teacher ID, the program will attempt to look up the
teacher ID in the Patron File. It will also tell you how many patrons do
not have a correct teacher ID referenced.
If there is not a correct teacher ID in the file, your checkout reports
will not be correct.
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About
The first screen of the About Dialog displays the application name and
author.
To move to the next screen, select the "More" push button.
About dialog, select the "OK" push button.

To exit the

The second screen of the About Dialog displays the following
information:
Resource File:
Location of the application resource file.
Configuration File: Location of the application configuration file
read when the application was started.

Home Directory: Directory where the application was loaded from or
where the application support libraries are stored.
The third screen of the About Dialog displays the following information
about the current hard disk:
Available Diskspace: Total amount of free disk space on the current
drive.
Temporary File Drive: Location where temporary files are created.
Temporary File Space: Total amount of free disk space on the
temporary file disk drive.
Temporary File Disk Size: Total disk space on temporary file disk
drive.
Current Directory: Default directory.
The fourth screen of the About Dialog displays the following environment
information:
Operating System: The operating system and version in use.
Comspec: Location of COMMAND.COM.
Windows Directory: The directory where Microsoft Windows (tm) is
installed. This information is only displayed if the application is
being run from within Windows.
Processor: The type of processor in use
FoxPro Version: Version of FoxPro in use.
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Version Date & Time: The Date and Time stamp of the version of
FoxPro.
The last screen of the About Dialog displays the following memory
information:
Total Available Memory: Total amount of available system RAM in
Kilobytes
Remaining Available Memory:
Kilobytes

Total amount of remaining RAM in

Available DOS Memory: Amount of DOS memory available in Kilobytes
Current Memory Usage: Amount of memory currently being used in
Kilobytes
EMS Memory In Use: Amount of Extended memory currently in use
Contents F1
This option displays the Help window. This is the built in "Help" system
for your program.
If you are on a specific item in the program and press F1, you'll get
help about that item.
If the screen is blank and or specific help item is referenced, a list
of help topics will appear. To get to a specific topic in the list,
begin typing the first few letters of the topic. Then, highlight the
topic you want and press <Enter> to get specific help about that topic.
Use the arrow keys, PageUp and PageDown keys to view the information on
the screen or use the mouse on the scroll arrows to the right of the
box.
Help Window Options
(when viewing a specific topic)
The help window has five commands (on the left of the help window).
These are:

1.

Topics
Press [T] for Topic or click on Topics with the mouse.
A list of
all the help topics available in the program will appear in a list form.
To get help on a specific topic, begin typing the first few letters of
the topic you want. Use the arrow keys to highlight the topic and press
<Enter> or click on it with the mouse . The detailed information about
that topic will be displayed.
2.

Next
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Press [N] or click on < Next> with the mouse to move to the next
help topic in the topics list.
3.

Previous
Press [P] or click on < Previous> with the mouse to move to the
previous help topic in the topics list.
4.

Look Up
You can highlight a key word in the help window when you're viewing
the information about a specific topic. Then, click on < Look Up > to
see if there are any references in the help file for that word.
5.

See Also
Use this option when viewing information about a specific topic to
look up a "Cross Referenced" related topic. To select this option press
[S] or click on <See Also> with the mouse. A list of related topics will
appear, if available. Type the first letter(s) of the topic you want to
see. Use the arrow keys to highlight the related topic or click on it
with the mouse to go to that related topic.
Note: To return to the Topic(s) you've already viewed, press [S] again.
Notice the line dividing the 'See Also' box. The topics above the line
are ones you've already viewed. The topics below the line are topics
still available for view. Highlight the topic you want to see and press
[Enter] or click on it with the mouse.
To Exit Help, press the <Esc> key or click the mouse in the upper left
and corner to clear the help window.
On Line Manual
This is a copy of the Library Wizard instructional manual. Use the
buttons at the bottom of the screen to browse the manual or look up
specific key words:
Top - First Page
Find - Type in key word(s) to look up. Don't worry about capitalization
Next - Next Page
Prev - Previous Page
Again - Find next occurrence of key word(s)
Last - Last Page
Go To - Go to a specific page
Use the buttons at the side of the page to go to a specific chapter or
section.
TOC - Table of Contents
Intro - Introduction
1- Chapter 1: Getting Started
2- Getting Around in the Program
3- File Menu options
4- Edit Menu options
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5- Command Window options
6- Output Menu (Reports)
7- Window Menu options
8- Utilities Menu options
9- Help Menu options
10- Administrator Menu options
Edit - Edit (add) information to this page.
Save - Save any changes made while editing this page.
Print On Line Manual
Use this option to print a copy of the on line manual to your printer.
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Administrator
This chapter explains the Administrator Menu options. This Menu will
only appear when the System Administrator is logged in. When you first
installed this program, the instructions explained how to log into this
program as the System Administrator:
ID: SYS
PASSWORD: PASSWORD
This is the ID and Password for the System Administrator when you
receive the program.
The System Administrator has total access to everything in the program.
As the System Administrator, you'll use the Administrator Menu options
to enter additional users for the program. You can also change the
password, under the 'Change Password' option of the Utilities Menu.
User Information
Use this screen to change all rights a specific user has when using the
program.
One person must have total rights to everything in the program. This
person is called the 'System Administrator'. If only one person is using
the program, this person should log in as the System Administrator.
The System Administrator uses this option to:
1) Add new users for the program.
2) Give Add, Edit, Delete, and View rights to each user.
3) Assign Group Managers.
4) Change individual user's password.
Adding New Users to the Program
Press [Ctrl+A] or click on < Add > with the mouse to add a new user. A
blank "User Information" window will appear.
Enter the following information:
First Name: Enter the first name of the user. For example, John.
Last Name: Enter the last name of the user. For example, Doe.
User Id: Enter a three letter user ID for this person. The initials of
the person are often used. However, this is a unique field. If two
people have the same initials, you must make them different in some way.
For example, LDA or LA2.
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Password: Enter the user's password. The user may change his/her
password from the 'Change Password' of the Utilities Menu. However, as
the System Administrator, you will always be able to view the user's
password from this option.
Group: If you want groups of people to use the same data files and have
the same rights, enter a group name. For example, PATRON.
Once you've set up all the rights for at least one member of this group
as explained in this chapter, you may add another person and enter their
group as PATRON. This new individual will have all the same rights
you've previously set up for the patron group... without going through
the "Rights" options for every file again.
System Administrator: One person is assigned the System Administrator.
This was already set up for you when you installed the program. The User
ID was 'SYS' and the Password was 'PASSWORD'.
Group Manager: If you assign groups of users, you may assign one or more
users as Group Managers.
The Group Manager may add new users and assign rights to this new user.
However, the Group Manager cannot assign rights he/she does not have.
The Group Manager doesn't necessarily have all the rights of the System
Administrator.
For example, a Group Manager may have all rights with respect to PATRON,
but no rights for any other group.
If a group manager is logged in, the Administrator Menu will appear on
the Master Menu.
Rights: Use this option to assign individual rights to each user. This
option determines whether a user may add, edit, or even view information
in a file.
This option is available when you are adding or editing information
about a user.
Press [Ctrl+A], [Ctrl+E], or click on
< Add > or < Edit >.
Use the arrow keys to highlight the file you want to assign user rights
on, and press [Enter] or double click on the file.
A "User Rights" window will appear.
Use the box at the top of the "User Rights" Window to assign the rights
a user may have in this file.
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These rights are explained below. To assign rights, click on it with the
box or press the underlined letter of the option. When the button to the
left of the option is filled, it means this is the right the person has
to this file.
•

Full Access - This allows the users to add, edit, or change any
information in this file.

•

Read Only - This allows the user to see information on the screen,
but he/she cannot add, edit, or change any information.

•

Add Only - This allows the user to see the information on the screen
and add new records to the file.

•

Edit Only - This allows the user to see the information on the screen
and edit existing records to the file.

•

Add + Edit (No Delete) - This allows the user to see the information
on the screen, add new records, or edit existing records. However,
this person may not delete any information.

•

No Access - This option prevents the user from even viewing the
information in the file.

Note: Ignore the box at the bottom of the "User Rights" screen.
Restricted Access information is not used in your program.

System Reports
User List
This option prints a list of users for the program.
Printer Setup - This option takes you to the Windows Printer Setup
Dialog to change printers, if needed.
Print - This option prints the List of Users to your printer.
Preview - This option prints the List of Users to the screen.
Done - Select this option to return to the Master Menu.
Error Log
Select "System Reports" under the Administrator Menu.
click on "Error Log".

Press [E] or

This report prints any problems that occurred while using the program.
This is primarily used by the System Administrator and technical support
for trouble shooting.
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Printer Setup - This option takes you to the Windows Printer Setup
Dialog to change printers, if needed.
Print - This option prints the List of Users to your printer.
Preview - This option prints the List of Users to the screen.
Done - Select this option to return to the Master Menu.
You will be asked whether you want to < Clear the error log file > upon
exit. Select < Yes > and the information in this error file will be
erased.
Note: Once a problem is resolved, there is no need to keep the
information on file.
Peer To Peer Networks
On peer to peer networks, like Lantastic, you will need to make certain
files READ ONLY if more than one person is to use the program at the
same time.
The current EPES Software programs for Windows are written using the
FoxPro database language. One of the programs you'll have in your main
directory after installing the program is called: FOX2600.ESL. This
program will be shared by all users. To do this on a peer to peer
network, go to the directory where the program was installed. For
example: F:\LIBW.
Type the following: ATTRIB +R FOX2600.ESL and press <Enter>.
You'll also need to do this for the main program. It ends in the suffix
.EXE.
For example, on the Library Wizard Software program, this file is
called: LIBW.EXE.
Type the following: ATTRIB +R LIBW.EXE and press <Enter>.
Installing the Program a Second Time
If you have to install the software again, for any reason, after you've
made these files READ ONLY as explained above, do the following:
1) Be sure no one is using the program. That means get everyone to exit
the program.
2) Go to the directory where the program is installed. For example:
F:\LIBW
3) Type: ATTRIB -R *.* and press <Enter>.
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Now you can install the software again. When you're done, you must make
the Fox2600.ESL and LIBW.EXE files READ ONLY as explained above if you
want more than one person to access the program at the same time.
If you do not follow these steps, you'll get an error message
"Permission Denied", when you install the software again.
Enter any notes that will help you with the program here.
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Accession No, 24
Accession Record, 52
Add, 17, 40
Add + Edit, 84
A dd Only, 84
Add OR, 50
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Administrator, 80
Administrator Menu, 80
Audiovisual, 25
Author, 26

—B—
Backup, 68
Bar Code Font, Installing, 10
Barcode Label, 27, 34
Barcode Labels, 56
Barcode Labels, Books, 56
Barcode Labels, Patrons, 56
Begins With, 45
Bibliography, Related Subjects, 53
Book Fines, Calculate, 63
Book Fines, Zero Out All, 63
Book Inventory, 65
Book Orders, 36, 53
Book Reports, 52
Books Out By Grade and Patron, 54
Books Read By Patrons, 55
Books, Barcode Labels, 56
Books, Library, 24
Bottom, 40
Browse, 41, 42

—C—
Calculate All Book Fines, 63
Calculate Current Fine, 32
Call Auth, 26
Call Num, 25
Cancel, 23, 43
Card Labels, 55
Cassettes, 25
Catalog Cards, 55
Check In Books, 32
Check In This Book, 32
Check Out Books, 31
Checkout Information, Erase, 65
Checkout Reports, 53
Circulation Reports, 54
City, 34
Clear, 20
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Comment, 26
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Contains, 46
Contents F1, 76
Convert Data From DOS, 72
Copy, 38
Copy Patrons From Floppy, 67
Copy Patrons To Floppy, 66
Copyright, 26
Cost, 27
Count, 42
Count of Books By Accession Number, 54
Count of Books By Date, 54
Credit for Fine Paid, 32
Ctrl+A, 40
Ctrl+B, 41
Ctrl+C, 38
Ctrl+D, 40
Ctrl+E, 40
Ctrl+End, 40
Ctrl+F, 42
Ctrl+Home, 40
Ctrl+M, 43
Ctrl+PgDn, 40
Ctrl+PgUp, 40
Ctrl+S, 43
Ctrl+V, 38
Ctrl+X, 38
Cut, 38

—D—
Daily Startup, 11
Date Due, Change, 66
Day Is, 48
Decimal Accession No, Adding, 30
Del, 40
Del (Delete), 17
Delete Patrons in One Grade, 68
Delete Saved Report, 73
Deleted Records, Erase, 60
Discarded, 27
Discarded Books, 52
Discarded Books, Erase, 64
Done, 44, 52

—E—
Edit, 17, 40
Edit Menu, 38
Ends With, 46
Erase Checkout Information, 65
Erase Deleted Records, 60
Erase Discarded Books, 64
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F1 Help, 76
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F8 Credit for Fine Paid, 32
Field List Box, 45
File Structure, Update, 61
Filter, 19
Filter, Clear, 43
Filter, Set, 20
Filters, Setting Multiple, 21
Find, 17, 42
First, 16
Flagged, 27
Flagged Books, 52
Full Access, 83
Funds, 27

—G—
Getting Around, 14
Grade, 33
Group, 81
Group Manager, 82

—H—
Help Menu, 74
Help Window Options, 76

—I—
ID, 11, 80
Ignore Case, 49
Import File, 70
In/Out, 25
Increment Patron Grade Level, 67
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Installation, 10
Introduction, 8
Inventory, 35
Inventory List of Books Out, 53
Inventory, Book, 65
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Is More Than, 20, 47
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—M—
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Master Menu, 12
Maximize, 58
Minimize, 58
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More, 22, 43
mouse, 14
Move, 57
Moving Around the Screen, 14

—N—
Negate, 49
Networks, Peer To Peer, 86
Next, 16, 40, 51, 77
No Access, 84

—O—
Office Clearance Notice, Print, 34
On Line Manual, 78
On Line Manual, Print, 79
Operator List Box, 45
Order, 43
Order By , 22
Orders to Books, Post, 63
Output Menu, 44
Output Order, 50
Overdue 1/3 Page, 53
Overdue By Patron By Grade, 53
Overdue By Teachers, 53
Overdue Patrons, Alphabetically, 54

—P—
Page, 52
Pages, 26
Password, 11, 80, 81
Password, Change, 68
Paste, 38
Patron, 33
Patron Address Information, 55
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Patron Id, 31, 33
Patron Reports, 54
Patron Utilities, 66
Patron, Type, 33
Patrons By Grade and Teacher, 54
Peer To Peer Networks, 86
Place, 26
Popup List, 15
Popup Screens, 15
Post Orders to Books, 63
Prev, 16, 40
Preview, 44, 51
Previous, 52, 77
Print, 44
Print On Line Manual, 79
Printer, 51
Printer Setup, 37
Program Preferences, 62
Publisher, 26
Purchased, 27

—Q—
Query Conditions Box, 50
Quick Overview, 13

—R—
Read Only, 83
Rebuild Indexes, 60
Recalculate Patron Books Out, 64
Re-Check Book, 31
Registration Form, 72
Related Subjects, 35
Related Subjects Bibliography, 53
Related Subjects Browse, 28
Remove, 50
Report Query Dialog, 44
Restore, 68
Retrieve, 51
Rights, 83
Room Number, 35

—S—
Save, 22, 43, 51
Section, 24
See Also, 77
Selecting Different Windows On Screen, 59
Selecting Report Information, 45
Set Filter, 20
Shelf List Report, 53
Size, 57
Source, 27
Spine Labels, 55
State, 34
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Title, 26
ToolBar Menu, 16
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Topics, 77
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—U—
Update File Structure, 61
User Id, 81
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User List, 84
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—W—
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Window Menu, 57
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